Dienstag, 23. Jänner 2024
APG (Austrian Power Grid) – OpenPDC, OpenHistorian2 & Sieggate Installation Wien

Vereinfachte Erklärung von OpenPDC, OpenHistorian2 und Sieggate: [image: ]
· OpenPDC empfängt die zeitsynchronisierten Daten der PMU über das C37.118 Protokoll. OpenPDC hat die erste Version von OpenHistorian bereits integriert, daher archiviert bereits OpenPDC die zeitsynchronisierten Daten. Mithilfe des OpenPDC Managers lassen sich die Werte grafisch darstellen. 
· OpenHistorian2 verwendet die von OpenPDC archivierten Daten und archiviert diese Daten in Stages. Hierbei gibt es Stage1, Stage2 und Stage3. Wenn die Daten als Stage1 eine gewisse Größe erreichen, dann werden diese Stage1 Daten zu Stage2 Daten. Das gleiche gilt für Stage3. 
· SIEGate ist ein Gateway, das den sicheren Austausch von Daten ermöglicht. Diese Daten werden gebraucht, um Echtzeit Kontrollraum-Operationen ausführen zu können. SIEGate ermöglicht den Austausch von großen Daten zu geringen Latenzen. Eine einzige Instanz von SIEGate ermöglicht den Austausch von 5 Million Messpunkten pro Sekunde. 

Meeting-Notes
Umsetzung WAMS: 
· Bekanntgabe der Ports:
· Server05 braucht zwei Ports: 
· Server03 => Server05 Port: 7265
· Server04 => Server05 Port: 7365
· Server03 => Server04 Port: 3343 (TCP + UDP Failover)
· Server04 => Server03 Port: 3343 (TCP + UDP Failover)
· Server Specs für GRID01
· Vorbereitung der initialne Dashboards gemäß Pflichtenheft
· Unterschrift NDA
· Aufsetzen der Server in GRID01
· Finaler Review Pflichtenheft 
· Weitere interne Klärung zu: 
· Python API
· Präzisierung Projektplan
· Definition der Abnahmekriterien für die jeweiligen Implementierungsschritte
· Test der Demonstrations-Website (Grafana Dashboard) 
Grid01 makes a connection with VPN to Grid02. 
OpenHistorian on Grid01. In Grid01 should be able to use csv. Grid01 is still used for the TUG (TU Graz) and csv-export. 
The Automatic job saves the csv-files in \\grid.inet\data\Applications\WAMS\Analyse
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Dokumentation der Installation bei APG (Austrian Power Grid)
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[bookmark: _Ref156920615]Abbildung 1: APG-Diagramm
URL zur Grid Protection Alliance-Confluence-Dokumentation: openPDC - User Knowledge base - Confluence (atlassian.net)

Zu Beginn müssen alle Installer auf die Server geladen werden, da man keinen Internetzugang hat am Server. 
1. Auf Server01 und Server02 wird nur openPDC installiert. 
2. Auf Server03 wird openHistorian und SQL Server (SQL Server Managment Studio) installiert.
3. Auf Server04 wird nur openHistorian installiert. 
4. Server03 und Server04 enthalten beide jeweils zwei Festplatten (D-Platte und E-Platte). 

Server01: 
· OpenPDC Installer auf lokalen PC herunterladen und dann auf die Virtuale Maschine verschieben, um es dann auf dem Server01 zu installieren. 
· OpenPDC Setup starten:
· Normale Schritte des Setups befolgen
· Speicherplatz von OpenPDC: C:/Program Files/openPDC
· Service Account: Standard Service Account: NT SERVICE\openPDC. Kein Passwort da wir Standard Service Account verwenden. Wenn wir von APG einen Service Account bekommen, dann wird NT Service\openPDC geändert. Stephen hat OpenPDC nochmal deinstalliert und startet die Installation noch ein zweites mal, da wir jetzt die Service Accounts bekommen haben. Anstatt NT SERVICE/openPDC verwenden wir nun den Service Account: GRID02\yyWAMSp_pdc. Da wir einen anderen Service Account als den Standard angegeben haben, mussten wir ein Passwort eingeben. 
· Company Name: Austrian Power Grid; Acronym: APG; System Name: Server 01
· Start the Install
· Install Finished
· Nachdem die Installation fertig ist, kommt man in das Configuration Setup Utility
· PMU Connection Tester installieren. Einfach alle Schritte befolgen und Next drücken. 
· Setup new Configuration für Database (Befindet sich ebenfalls im Configuration Setup Utility; Die nächsten Punkte beschreiben die Einstellungen der Database):
· Set up existing configuration 
· Check “I want to set up a new configuration”.
· Select configuration type:
· Check “Database”. 
· Set up a database
· “SQL Server”
· “Run initial data script”
· Set up a SQL Server database
· Hostname: VBS2EWAMP3/SQLEXPRESS,1433 (No space)
· Database name: openPDC_Server01
· Test connection
· Define User Account Credentials
· Check “Windows Authentication”
· Username: GRID02\admintrk
· Password: Wurde nicht gebraucht, da wir den User (admintrk) verwendet haben, mit welchen wir eingeloggt waren. 
· Apply configuration changes 
· Check “openPDC Windows service”
· Check “openPDC Manager”
· Check “Setup / change primary historian”
· Set up primary historian
· Verwende “Local v1.0 openHistorian (…..)”
· Set up historian connection string
· Zuerst die OpenPDC Installation erledigen, dann kann man die openPDC.exe.Config-Datei verändern. Dieser Schritt wird unten im „Temporary OpenPDC Archive Settings”-Bereich beschrieben. 
· Configuration setup complete
· “Finish”
· Benutzer:
· Weil wir mit Konstantins Account eingeloggt sind, müssen wir im Webinterface neue Benutzer hinzufügen, damit wir ins Webinterface mit anderen Benutzern einloggen können. 
· Add Users: 
· Openhistorian Webinterface => Settings => Users => Add New => Name: Grid02\zzGriWis (Wenn User wirklich existiert, dann schreibt das Webinterface „Resolved account name“); Check the “Active Directory User”; Firstname: Stephen; Lastname: Wills
· Rollen zu den Benutzern hinzufügen 
· Hinzugefügte Benutzer sind: 
· zzGriWis (Rolle: Admin)
· Lenzmart (Rolle: Editor)
· Admintrk (Rolle: Admin)
· Adminfec (Rolle: Admin)
· Adminsam (Rolle: Admin)
· zzGriLac (Rolle: Admin)
· zzArtAum (Rolle: Admin)
· zzGriWie (Rolle: Admin)
· zzArtGsd (Rolle: Admin)
· Temporary OpenPDC Archive Settings:
· openPDC.exe.Config-Datei muss geändert werden:
· Im Abschnitt <ppaArchiveFile> der Datei:
· Veränderte Einstellung name=“ArchiveOffloadLocation“
· value=“*DELETE*“
· Veränderte Einstellung name=“ArchiveOffloadThreshold“
· value=“80“
· Veränderte Einstellung name=“ArchiveOffloadMaxAge“
· value=“1“
Server02:  
· OpenPDC Installer auf lokalen PC herunterladen und dann auf die Virtuale Maschine verschieben, um es dann auf dem Server02 zu installieren. 
· OpenPDC Setup starten:
· Normale Schritte des Setups befolgen
· Speicherplatz von OpenPDC: C:/Program Files/openPDC
· Service Account: GRID02\yyWAMSp_pdc. Da wir einen anderen Service Account als den Standard angegeben haben, mussten wir ein Passwort eingeben. 
· Company Name: Austrian Power Grid; Acronym: APG; System Name: Server 02
· Start the Install
· Install Finished
· Nachdem die Installation fertig ist, kommt man in das Configuration Setup Utility
· PMU Connection Tester installieren. Einfach alle Schritte befolgen und Next drücken. 
· Setup new Configuration für Database (Befindet sich ebenfalls im Configuration Setup Utility; Die nächsten Punkte beschreiben die Einstellungen der Database):
· Set up existing configuration 
· Check “I want to set up a new configuration”.
· Select configuration type:
· Check “Database”. 
· Set up a database
· “SQL Server”
· “Run initial data script”
· Set up a SQL Server database
· Hostname: VBS2EWAMP3/SQLEXPRESS,1433 (No space)
· Database: openPDC_Server02
· Test connection
· Define User Account Credentials
· Check “Windows Authentication”
· Username: GRID02\admintrk
· Password: Wurde nicht gebraucht, da wir den User verwendet haben, mit welchen wir eingeloggt waren. 
· Apply configuration changes 
· Check “openPDC Windows service”
· Check “openPDC Manager”
· Check “Setup / change primary historian”
· Set up primary historian
· Verwende “Local v1.0 openHistorian (…..)”
· Set up historian connection string
· Zuerst die OpenPDC Installation erledigen, dann kann man die openPDC.exe.Config-Datei verändern. Dieser Schritt wird unten im „Temporary OpenPDC Archive Settings”-Bereich beschrieben. 
· Configuration setup complete
· “Finish”
· Benutzer:
· Weil wir mit Konstantins Account eingeloggt sind, müssen wir im Webinterface neue Benutzer hinzufügen, damit wir ins Webinterface mit anderen Benutzern einloggen können. 
· Add Users: 
· Openhistorian Webinterface => Settings => Users => Add New => Name: Grid02\zzGriWis (Wenn User wirklich existiert, dann schreibt das Webinterface „Resolved account name“); Check the “Active Directory User”; Firstname: Stephen; Lastname: Wills
· Rollen zu den Benutzern hinzufügen 
· Hinzugefügte Benutzer sind: 
· zzGriWis (Rolle: Admin)
· Lenzmart (Rolle: Editor)
· Admintrk (Rolle: Admin)
· Adminfec (Rolle: Admin)
· Adminsam (Rolle: Admin)
· zzGriLac (Rolle: Admin)
· zzArtAum (Rolle: Admin)
· zzGriWie (Rolle: Admin)
· zzArtGsd (Rolle: Admin)
· Temporary OpenPDC Archive Settings:
· openPDC.exe.Config-Datei muss geändert werden:
· Im Abschnitt <ppaArchiveFile> der Datei:
· Veränderte Einstellung name=“ArchiveOffloadLocation“
· value=“*DELETE*“
· Veränderte Einstellung name=“ArchiveOffloadThreshold“
· value=“80“
· Veränderte Einstellung name=“ArchiveOffloadMaxAge“
· value=“1“

Server03: 
· SQL-Server Installer auf Server-03 geladen und Installation gestartet:
· Die verschiedenen Domain User zu SQL-Server hinzufügen
· zzARTAUM (Matthias Ausserwinkler)
· … (Wills Stephen)
· … (Cristoph Lackner)
· … (Wills Erica)
· … (Gschliesser Daniel)
· SSMS (SQL Server Managment Studio) auf Server installieren
· SQL-Server Einstellung: Stephen hat im „SQL Server Configuration Manager“ unter „Protocols for SQLEXPRESS“ => TCP/IP drücken => Enabled zu YES => IP Adress Tab => Ganz nach unten scrollen => Unter IPALL soll TCP Port auf 1433 gesetzt. 
· Trotz der Einstellung unter SQL Server Configuration Manager konnte keine Verbindung mit Server01 und dem SQL-Server von Server03 hergestellt werden. Wahrscheinlich muss die Firewall eingestellt werden. 
· OpenHistorian:
· HistorianArchive01-Ordner auf der D-Festplatte erstellt und in diesem Ordner befindet sich ein weiterer Ordner namens Data. Auf der E: Platte befindet sich dann der HistorianArchive02-Ordner, welcher ebenfalls einen Ordner namens Data enthält. Soll wie in Abbildung 1: APG-Diagramm (FS 01 & FS 02) sein. 
Hinweis: Wir haben Server03 und Server04, welche jeweils zwei Platten (D-Platte und E-Platte) für Openhistorian verwenden. Diese Platten werden für File Sharing verwendet. 
· Auf der D:-Festplatte wird noch ein Ordner namens WorkingArchive erstellt.
· File-Sharing and Permissions:
· File-sharing zwischen Server03 und Server04. Rechtsklick auf HistorianArchive01-Ordner (Auch das gleiche für HistorianArchive02-Ordner durchführen). Properties => Sharing => Advanced Sharing => Check “Share this folder” => Press “OK”. Bevor auf “OK” gedrückt wird, müssen die Permissions eingestellt werden:
· Permissions => Add => Enter the object name to select => yyWAMSp_historian => Check Names => “OK” 
· Dem hinzugefügten Benutzer müssen die Rechte nun vergeben werden. Dem Benutzer sollen alle Rechte (Full Control) gegeben werden.
· File-sharing für WorkingArchive. Rechtsklick auf WorkingArchive-Ordner. Eigenschaften => Freigabe => Erweiterte Freigabe => “Diesen Ordner freigeben” ankreuzen => Press “OK”. Bevor auf “OK” gedrückt wird, müssen die Berechtigungen eingestellt werden:
· Berechtigungen => Hinzufügen => Geben Sie die zu verwendenden Objektnamen ein => yyWAMSp_historian => Namen überprüfen => “OK” 
· Dem hinzugefügten Benutzer müssen die Rechte nun vergeben werden. Dem Benutzer soll Vollzugriff (Full Control) gegeben werden.
· Lokale Dateien Rechte: 
· Rechtsklick auf den HistorianArchive01-Ordner => Eigenschaften => Zu Sicherheit Tab wechseln => Erweitert => Add => Principal auswählen => Im „Geben Sie die zu verwendenden Objektnamen ein“- Feld, soll „yyWAMSp_historian“ eingegeben werden => Namen überprüfen => „OK“ => Vollzugriff (Full control) => „OK“ => „OK“ => „OK“.
· Diesen Schritt für HistorianArchive02 und WorkingArchive wiederholen. 
· Das Setup von Openhistorian starten: 
· Normale Schritte des Setups befolgen. 
· Speicherplatz: C:\Program Files\openHistorian\
· Service Account: GRID02\yyWAMSp_historian. Passwort wird wieder benötigt. 
· Company Name: Austrian Power Grid; Acronym: APG; 
System Name: Server 03
· Install
· Jetzt befinden wir uns im Configuration Setup Utility:
· Set up existing configuration:
· Box „I want to set up a new configuration” ankreuzen. “Next” drücken.
· Select configuration type
· “Database” ankreuzen. “Next” drücken.
· Set up a database
· “SQL-Server” und „Run inital data script“ ankreuzen. “Next” drücken. 
· Set up a SQL Server database
· Host name: localhost/SQLEXPRESS (Hier wird localhost verwendet, da der SQL-Server auf Server03 installiert ist)
· Database name: openHistorian_Server03
· Define User Account Credentials
· User name: GRID02\admintrk
· Password: Bleibt leer, da es der Account ist, mit dem wir eingeloggt sind. 
· Apply configuration changes
· Alle angekreuzten Checkboxes einfach so lassen wie sie standardmäßig sind.
· Setup primary historian (Für das Archiv)
· openHistorian 2.0 (Local) wird verwendet. 
· Der Rest bleibt so wie es ist. 
· Set up historian connection string:
· Gewählte Parameter (Parameter warden ausgewählt und dann kann man einen Value hinzufügen):
· ArchiveDirectories = \\vjb2EWAMP3\HistorianArchive03\Data; \\vbs2EWAMP3\HistorianArchive01\Data;
\\vjb2EWAMP3\HistorianArchive04\Data;
\\vbs2EWAMP3\HistorianArchive02\Data;
· WorkingDirectory = D:\WorkingArchive\Data;
· AttachedPaths = \\vjb2EWAMP3\WorkingDirectory\Data; \\vbs2EWAMP3\WorkingDirectory\Data; 
· DownsamplingIntervals = ( 180 = 10; 360 = 1; )
· MaximumArchiveDays = 720
· Configuration setup complete
· Benutzer:
· Weil wir mit Konstantins Account eingeloggt sind, müssen wir im Webinterface neue Benutzer hinzufügen, damit wir ins Webinterface mit anderen Benutzern einloggen können. 
· Add Users: 
· Openhistorian Webinterface => Settings => Users => Add New => Name: Grid02\zzGriWis (Wenn User wirklich existiert, dann schreibt das Webinterface „Resolved account name“); Check the “Active Directory User”; Firstname: Stephen; Lastname: Wills
· Rollen zu den Benutzern hinzufügen 
· Hinzugefügte Benutzer sind: 
· zzGriWis (Rolle: Admin)
· Lenzmart (Rolle: Editor)
· Admintrk (Rolle: Admin)
· Adminfec (Rolle: Admin)
· Adminsam (Rolle: Admin)
· zzGriLac (Rolle: Admin)
· zzArtAum (Rolle: Admin)
· zzGriWie (Rolle: Admin)
· zzArtGsd (Rolle: Admin)
Server04: 
· OpenHistorian: 
· HistorianArchive03-Ordner auf der D-Festplatte erstellt und auf E-Festplatte befindet sich HistorianArchive04. Innerhalb beider Ordner befindet sich ein Data-Ordner. Gleich wie bei Server03. 
· File-Sharing and Permissions: 
· File-sharing zwischen Server03 und Server04. Rechtsklick auf HistorianArchive03-Ordner (Auch das gleiche für HistorianArchive04-Ordner durchführen). Properties => Sharing => Advanced Sharing => Check “Share this folder” => Press “OK”. Bevor auf “OK” gedrückt wird, müssen die Permissions eingestellt werden:
· Permissions => Add => Enter the object name to select => yyWAMSp_historian => Check Names => “OK” 
· Dem hinzugefügten Benutzer müssen die Rechte nun vergeben werden. Dem Benutzer sollen alle Rechte (Full Control) gegeben werden.
· File-sharing für WorkingArchive. Rechtsklick auf WorkingArchive-Ordner. Eigenschaften => Freigabe => Erweiterte Freigabe => “Diesen Ordner freigeben” ankreuzen => Press “OK”. Bevor auf “OK” gedrückt wird, müssen die Berechtigungen eingestellt werden:
· Berechtigungen => Hinzufügen => Geben Sie die zu verwendenden Objektnamen ein => yyWAMSp_historian => Namen überprüfen => “OK” 
· Dem hinzugefügten Benutzer müssen die Rechte nun vergeben werden. Dem Benutzer soll Vollzugriff (Full Control) gegeben werden.
· Lokale Dateien Rechte: 
· Rechtsklick auf den HistorianArchive03-Ordner => Eigenschaften => Zu Sicherheit Tab wechseln => Erweitert => Add => Principal auswählen => Im „Geben Sie die zu verwendenden Objektnamen ein“- Feld, soll „yyWAMSp_historian“ eingegeben werden => Namen überprüfen => „OK“ => Vollzugriff (Full control) => „OK“ => „OK“ => „OK“.
· Diesen Schritt für HistorianArchive04 und WorkingArchive wiederholen. 
· Das Setup von Openhistorian starten: 
· Normale Schritte des Setups befolgen. 
· Speicherplatz: C:\Program Files\openHistorian\
· Service Account: GRID02\yyWAMSp_historian. Passwort wird wieder benötigt. 
· Company Name: Austrian Power Grid; Acronym: APG; 
System Name: Server 04
· Install
· Jetzt befinden wir uns im Configuration Setup Utility: (Wir werden eine bereits existierende Configuration bei Server04 verwenden).
· Set up existing configuration 
· Box „I want to use an existing configuration” ankreuzen. 
· Select configuration type 
· Check “Database” 
· Database schema update
· Box “I want to use an existing database as-is” ankreuzen.
· Set up a database
· Check “SQL Server”
· Set up a SQL Server database
· Hostname: VBS2EWAMP3\SQLEXPRESS,1433
· Databasename: openHistorian_Server03
· Test connection
· Apply configuration changes
· Box “openHistorian Windows service” ankreuzen
· Box “openHistorian Manager” ankreuzen
· Node selection
· Wir verwenden das default-Node
· Name: Default; Company: Empty; Description: Default node;
· Configuration setup complete

Verbindung mit OpenHistorian (Server04) zu beiden OpenPDC Server herstellen:
· OpenHistorian zu OpenPDC (Server01)
· OpenHistorian Manager => Inputs => Subscription Based Inputs => Create Internal Subscription => Bei diesen Schritt sollen die Werte der unten stehenden Aufzählungen eingeben werden: => Next
·  Acronym: SERVER01
· Name: Server 01 (VBS2EWAMP2)
· Hostname: VBS2EWAMP2 
· Port: 7165
· Protocol: STTP
· Uncheck the Checkbox “Use Source Prefix”
· Checkbox “Enable Automated Data Gap Recovery” ankreuzen
· Recovery Start Delay = 20 
· Minimum Recovery Span = 30
· Recovery Processing Interval = 66
· Data Monitoring Interval = 10
· Maximum Recovery Span = 10
· Logging Path = ConfigurationCache
· Wenn “Next” gedrückt wurde, sollte das folgende Fenster auftauchen: 
· [image: Ein Bild, das Text, Elektronik, Screenshot, Software enthält.
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· Der gesamte Connectionstring, welcher im Bild nicht zusehen ist:
· autoSynchronizeMetadata=false; filterOutputMeasurements=false; interface=0.0.0.0; useSourcePrefixNames=false; compression=true; autoConnect=true; securityMode=None; server=VBS2EWAMP2:7165; internal=True; receiveInternalMetadata=True; receiveExternalMetadata=False; outputMeasurements={FILTER ActiveMeasurements WHERE Protocol = 'STTP'}; dataGapRecovery={enabled=true; recoveryStartDelay=20; dataMonitoringInterval=10; minimumRecoverySpan=30; maximumRecoverySpan=864000; recoveryProcessingInterval=66}; loggingPath=ConfigurationCache
· Letzter Schritt ist es auf „Save“ zu drücken. 
· OpenHistorian zu OpenPDC (Server02)
· OpenHistorian Manager => Inputs => Subscription Based Inputs => Create Internal Subscription => Bei diesen Schritt sollen die Werte der unten stehenden Aufzählungen eingeben werden: => Next
· Acronym: SERVER02
· Name: Server 02 (VJB2EWAMP2)
· Hostname: VJB2EWAMP2
· Port: 7165
· Protocol: STTP
· Uncheck the Checkbox “Use Source Prefix”
· Checkbox “Enable Automated Data Gap Recovery” ankreuzen
· Recovery Start Delay = 20 
· Minimum Recovery Span = 30
· Recovery Processing Interval = 66
· Data Monitoring Interval = 10
· Maximum Recovery Span = 10
· Logging Path = ConfigurationCache
· Wenn “Next” gedrückt wurde sollte das folgende Fenster auftauchen:
· Das Acronym im folgenden Bild sollte SERVER02 lauten
· Der Name im folgenden Bild sollte Server 02 (VJB2EWAMP2)
· [image: Ein Bild, das Text, Screenshot, Software, Webseite enthält.
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· Der gesamte Connectionstring, welcher im Bild nicht zusehen ist:
· interface=0.0.0.0; useSourcePrefixNames=false; compression=true; autoConnect=true; securityMode=None; server=VJB2EWAMP2:7165; internal=True; receiveInternalMetadata=True; receiveExternalMetadata=False; outputMeasurements={FILTER ActiveMeasurements WHERE Protocol = 'STTP'}; dataGapRecovery={enabled=true; recoveryStartDelay=20; dataMonitoringInterval=10; minimumRecoverySpan=30; maximumRecoverySpan=864000; recoveryProcessingInterval=66}; loggingPath=ConfigurationCache
· Letzter Schritt ist es auf „Save“ zu drücken. 
· Falls ein Error in der OpenHistorian Console auftaucht, dann muss man den OpenHistorian Dienst neustarten. 

Verbindung von OpenPDC (Server01) zu OpenPDC (Server02)
· OpenPDC Manager => Inputs => Subscription Based Inputs => Create Internal Subscription => Bei diesen Schritt sollen die Werte der unten stehenden Aufzählungen eingeben werden: => Next
· Acronym: SERVER02
· Name: Server 02 (VJB2WAMP2)
· Hostname: VJB2WAMP2
· Port: 7165
· Protocol: STTP
· Uncheck the Checkbox “Use Source Prefix”
· Wenn “Next” gedrückt wurde, dann sollte das folgendes Fenster auftauchen:
· [image: Ein Bild, das Text, Screenshot, Software, Webseite enthält.
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· Der gesamte Connectionstring, welcher im Bild nicht zu sehen ist:
· interface=0.0.0.0; useSourcePrefixNames=false; compression=true; autoConnect=true; securityMode=None; server=VJB2WAMP2:7165; internal=True; receiveInternalMetadata=True; receiveExternalMetadata=False; outputMeasurements={FILTER ActiveMeasurements WHERE Protocol = 'NoData'}
· Letzter Schritt ist es auf „Save“ zu drücken. 


Hinzufügen von PMUs zu OpenPDC:
· OpenPDC auf Server02:
· PMU Connection Tester
· Host IP: 10.234.93.43
· Port: 4713 (Port für das Primäre System); Port für das Sekundäre System ist 4714;
· Protocol: IEEE C37.118-2005
· Device-ID: 1852
· Auf „Connect“ drücken
· Nachdem man verbunden ist, muss man manuell einen Command schicken:
· Command: Send Config Frame 2
· „Send“
· Wenn es funktioniert, dann sollte ich im PMU Connection Tester sehen das Daten ankommen. 
· File => Connection => Save => Connection-File irgendwo abspeichern (Damit man die Connection in OpenPDC einfach laden kann). 
· Nachdem abspeichern des Files unbedingt “Disconnect“ in PMU Connection Tester drücken. 
· Für alle PMUs durchführen.
· OpenPDC
· Auf „Input Device Wizard“ drücken. 
· Im „Input Device Wizard“ wird gefragt, ob man ein Connection File vom PMU Connection Tester erstellt hat. (Das was wir zuvor abgespeichert haben). 
· Wenn das Connection File ausgewählt wird, dann fragt OpenPDC, ob man eine Verbindung erstellen will. Drücke „Yes“. 
· Nachdem man auf „Yes“ gedrückt hat, muss man auf „Request Configuration“ drücken.
· Im nächsten Fenster einfach „OK“ drücken
· „Finish“ 
· Nachdem man „Finish“ gedrückt hat, muss man die Konfiguration kontrollieren. Im folgenden Bild wurde die Spalte „Phase“ und „Base kV“ verändert. Außerdem wurden die Breiten- und Längengrade hinzugefügt. 
· [image: Ein Bild, das Text, Screenshot, Software, Computersymbol enthält.
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· Auf „Finish“ wieder drücken. 
· Nachdem die PMU hinzugefügt wurde, kann man unter (Monitoring => Graph Measurement) die PMU und ihre Werte sehen. 
· Dadurch das die PMUs auf Server02 im OpenPDC hinzugefügt wurden, wurden die Einträge automatisch auf Server01 im OpenPDC hinzugefügt. 
· Wenn die PMUs in OpenPDC hinzugefügt wurden, dann sollten sie automatisch in OpenHistorian auch angezeigt werden (Laut Stephen)

· Verbinden von PMUs auf Server01:
· Die PMUs sollten im OpenPDC auf Server01 automatisch aufgelistet sein, wenn man zuvor die PMUs über Server02 hinzugefügt hat. Jedoch sind bei den PMUs der falsche Concentrator eingetragen. Aus diesem Grund muss bei allen PMUs der Concentrator geändert werden. 
· OpenPDC Manager:
· Auf “Browse Input Device” drücken
· Auf ein Gerät drücken 
· Oben rechts befindet sich Concentrator 
· Hier befindet sich als Eintrag „SERVER02“ 
· Ändern zu „Select Device“
· Im gleichen Fenster muss ebenfalls Protokoll geändert werden. „STTP“ zu „IEEE C37.118-2005“
· Darauf muss man zurück auf Server02 gehen, um den Connectionstring desselben Gerätes zu kopieren. Dann wieder zurück zum Server01 und den kopierten Connectionstring im selben Gerät einfügen. Und bei diesem eingefügten Connectionstring muss der Port von 4713 zu 4714 geändert werden. 
· Da es ein Problem mit dem Komma bei Latitude und Longitude gibt, müssen diese Werte ausgetragen werden und irgendwo anders zwischengespeichert werden. 
· Auf „Save“ drücken.
· OpenPDC Webinterface:
· Nun muss man das OpenPDC Webinterface öffnen. Im Webinterface zu „Browse Devices“ gehen und den gerade im OpenPDC Manager veränderte Gerät bearbeiten. Und jetzt muss der zwischengespeicherte Längengrad und Breitengrad im Webinterface eingeben werden. 
· Bei „Interconnection“ muss „Europe“ angegeben werden und bei „Company“ muss „APG“ angegeben werden. 
· „Save“ im Webinterface drücken. 

Wie man ein Gerät deaktiviert:
· Öffne das OpenPDC Webinterface
· Zu „Browse Devices“ gehen. 
· Und dann in der „Enabled“ Spalte einfach auf die Checkbox drücken, damit das Häkchen ausgeblendet wird.
· Das Aktivieren und Deaktivieren von Geräten ist sehr wichtig für Troubleshooting. Wenn das Gerät im OpenPDC immer noch aktiviert ist, dann kann man z.B im PMU Connection Tester keine Verbindung aufbauen!!!

Grafana
· Ein neues Dashboard erstellen
· Öffne das Openhistorian Webinterface
· „Grafana Visualizations“ drücken (Bringt einen zum Home Dashboard)
· Auf das Menü gehen => Auf „Dashboards“ drücken
· Auf der rechten Seite auf „New“ drücken. 
· Auf „Add Visualization“ drücken. 
· Darauf sollte man ein Dashboard erstellen können. Hierbei sollte die Data source „OHDATA“ bereits geladen sein. 
· Nach unten scrollen zu „Data Selection“. Im Query Bereich auf „Filter“ drücken. 
· Nach dem drücken auf „Filter“ sollte unterhalb eine neue Zeile auftauchen. In der neu hinzugefügten Zeile nach „ActiveMeasurement“ suchen und auswählen. 
· Im „Where“-Bereich dieser neuen Zeile muss man „SignalType = ‘FREQ‘ “ angeben, damit die Daten im Panel angezeigt werden. 
· Rechts oben findet man den „Apply“-Button.  
· Dashboard mit Landkarte erstellen
· Ein neues Dashboard erstellen 
· Auf „Time Series“ drücken und „Geomap“ auswählen
· Auf der rechten Seite runter scrollen zu „Basemap Layer“
· „Default base layer“ zu „XYZ Tile Layer” (XYZ Tile Layer ist dafür, das die Maps von der angegebenen URL geladen werden und nicht von Internet)
· In der „URL Template“ Zeile muss die folgende URL eingeben werden: 
· http://localhost:8180/Maps/openstreet/{z}/{x}/{y}.png
· Import/Export Dashboard
· Man muss den “Share”-Button suchen und dann kann man das Dashboard exportieren. 
· Im Menü unter Dashboard muss man auf „New“ drücken und dann kann man Import auswählen. 
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